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the information contained herein. StarWind Software reserves the right to make changes in the product
design without reservation and without notification to its users.
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INTRODUCTION

StarWind Virtual SAN™ is a native Windows hypervisor-centric hardware-less VM storage solution.
It creates a fully fault tolerant and high performing storage pool purpose built for the virtualization
workloads by mirroring existing server’s storage and RAM between the participating storage cluster
nodes. The mirrored storage resource is then connected to all cluster nodes treated just as local storage
by both hypervisors and clustered applications. Fault tolerance is achieved by providing multipathed
access to all storage nodes. StarWind Virtual SAN delivers supreme performance compared to any
dedicated SAN solution since it runs locally on the hypervisor and all 1O is processed by local RAM, SSD
cache, and disks and never bottlenecked by storage fabric.

This guide provides detailed instructions on installation, registration, and detailed steps that are need
to be taken to create StarWind Virtual SAN High-Availability Device. It also highlights how to connect
to the StarWind HA data store with the Microsoft iSCSI initiator. Additionaly you can find step-by-step
guidance on how to create the Hyper-V cluster and configure the StarWind shared storage as the
Cluster Shared Volumes.

A full set of up-to-date technical documentation can always be found here, or by pressing the Help
button in the StarWind Management Console.

For any technical inquiries please visit our online community, Frequently Asked Questions page, or use
the support form to contact our technical support department.

©2014,Starind Software Inc. Al ghts reserved. 4


http://www.starwindsoftware.com/technical-papers
http://www.starwindsoftware.com/forums/
http://www.starwindsoftware.com/starwind-faq
http://www.starwindsoftware.com/support-form

HARDWARE-LESS VM STORAGE = StarW:nd

S O FTWARE

PRE-CONFIGURING THE SERVERS

Here is a reference network diagram of the configuration described in this guide.

LAN + ClusterNetwork + HeartBeat
(172.16.0.%)

o gsv?2

Syncl (172.16.110.%)
iSCS| Datal (172.16.210.%)

_ Witness

Sync2 (172.16.111.%)
iSCSI Data2 (172.16.211.%)

The Sync and iSCSI data are direct links between the servers with 2 VLANs dedicated in each link.

This document assumes that you have a domain controller and you have added the servers to the
domain. It also assumes that you have installed the Failover Clustering and Multipath I/O features,
as well as the Hyper-V role on both servers. These actions can be performed using Server Manager
(the Add Roles and Features menu item).

1. In order to allow StarWind Virtual SAN to use the Loopback accelerator driver and access the local
copy of the data faster you have to add a minor modification to the StarWind configuration file.
Locate the configuration and open it using Notepad. The default path is:

C:\Program Files\StarWind Software\StarWind\StarWind.cfg

2. Find the string «<!--<iScsiDiscoveryListnterfaces value=»1»/> -->» and uncomment it (should look
as follows: <iScsiDiscoveryListinterfaces value=»1»/>). Save the changes and exit Notepad.

Should there be any issues saving the document, launch Notepad with Administrator rights and then
load the starwind.cfg file to do the modifications.

3. Restart the StarWind Service and repeat the same procedure on the second StarWind node.

©2014,Starind Software Inc. Al ghts reserved. 5
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DOWNLOADING, INSTALLING, AND REGISTERING THE SOFTWARE

1. Download the StarWind setup executable file from our website:
http://www.starwindsoftware.com/registration-starwind-virtual-san

Note: The setup file is unified for x86 and x64 systems, as well as for all Virtual SAN deployment
scenarios.

2. Launch the downloaded setup file on the server where you wish to install StarWind Virtual SAN or
one of its components. The Setup wizard will appear:

Setup - StarWind -[= %

Welcome to the Starwind Setup
Wizard

This will install Starbind +.8.0.6838 {build 20140530} on your
cormputer,

It is recommended that vou close all other applications before
continuing,

Click Mext to continue, or Cancel to exit Setup,

Mext = || Cancel

Click Next to continue.

3. Read and accept the License Agreement.

S Setup - StarWind

License Agreement
Please read the fallawing important information befare continuing.

Please read the following License Agreement, You must accept the kerms of this
agreement before continuing with the installation,

Starwind Software ~

Starwind iSCSI Target Starwind Software End User License Agreement

IMPORTAMT - READ BEFORE COPYIMG, IMSTALLING OR LISING

Do ok use o load install this software the Starwind iSCSI Target or any

associated matetials (collectively refered to as, the "Software™) until you have
carefully read the Following terms and conditions. By loading instaling or using the
Software, you agree ko the kerms of this Agreement. IF vou do not wish to so h

() 1 do not accept the agreement

< Back || Mext = || Cancel

Click Next to continue.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 6
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4. Carefully read the information about new features and improvements.
Red text indicates warnings for users who are updating existing software installation.

(=) Setup - StarWind

Information
Flease read the Following important information before continuing.

When vou are ready to continue with Setup, click MNext,

Starwind iSCSI SAN Version V8 ~

MNew Features and Improvements

Mew Log-structured File System container

It implements thin-pravisioning, snapshaots, optional dedoplication.
Synchronous and asynchronous replication can be configured for a
LEFS device.

LSFS device is flash-friendly. It eliminates multiple rewtrites of same w

< Back || Mext = || Cancel

Click Next to continue.

9. Click Browse to modify the installation path if necessary.

(=} Setup - StarWind - |[=] x|

Select Destination Location
Where should Starvwind be installed?

| Setup will install Stariwind into the Fallowing Folder.

To cantinue, dick Mext, IF vou waould like bo select a different Falder, click Brawse.

:Z:'IF'rEu:lrarn FilesStaritind Softwaret Stariind | | Browse. ..

At least 1,4 MB of free disk space is required.

< Back || Mext = || Cancel

Click Next to continue.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 1
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6. Specify one of the following installation types:

* Full installation (recommended)
Full installation includes both StarWind Service and the Management Console elements. It allows
users to manage storage resources on the machine where StarWind Virtual SAN is installed, as well
as manage other StarWind Virtual SAN installations on the network.

* StarWind Virtual SAN Service
This installation type is designed for Core OS editions. StarWind Service is the core of the software.
It enables the creation of iSCSI targets as well as sharing virtual and physical devices. The service can
be managed using StarWind Management Console from any Windows computer on the network.

* StarWind Management Console
The Management Console is the Graphic User Interface (GUI) part of the software that controls
and monitors all storage-related operations (e.g. allows users to create targets and devices on the
available Virtual SAN servers). Once installed, StarWind Management Console is connected to the
servers running StarWind Virtual SAN.

(=} Setup - StarWind

Select Components
Which components should be installed?

Select the components you wank to install; clear the components you do not want ko
install, Click Mext when you are ready ko continue,

|FuII installation iV
iSCSI Server 11,0MB | A
Loopback Accelerator Driver
Management Console 50,1 MB
- [#] ¥SAN Deployment Tool 11,8 MB | =
- [W] Mas Configuration Taol 1,4 MB
L [ w2¥ Converter Tool 4,8 ME
Skariwindy Library z,7 MB
. [v] Powershell Management Library 0,9 MB
[+1 SMI-5 Aaent 47.7MB

Current selection requires at least 112,3 ME of disk space.

< Back || Mext = || Cancel

Click Next to continue.

©2014,Starind Software Inc. Al ghts reserved. 8
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1. Specify the Start Menu folder.
(=) Setup - StarWind

Select Start Menu Folder
Where should Setup place the program's shortouts?

o
|;| Setup will creake the program's shorkcuts in the Following Start Menu Folder,
[ ]

To continue, dick Mext, IF vou would like to select a different Folder, click Browse.

=-tar"-.-'n.-'iru:1 Software)skarwind | | Browse. ..

< Back || Mext = || Cancel

Click Next to continue.

8. Enable the checkbox if you want to create a desktop icon.

(=) Setup - StarWind

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks wou would like Setup to perform while installing Skarind,
then click Mext,

Additional icons:

< Back || Mext = || Cancel

Click Next to continue.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 9
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9. You will be prompted to request a time-limited fully functional evaluation key, or a FREE version key,
or a fully commercial license key sent to you with the purchase of StarWind Virtual SAN. Select the
appropriate option.

(=] Setup - StarWind -[of *x ]

License key
Get vour license key

Mow when you have installed Starwind you need to apply either evaluation key or
FREE wersion key or cormercial license key vou've got with vour purchase, IF vou
dont have any key it’s time to request one now!

®) Request time-limited Fully Funckional evaluation ke

() Request FREE version key
) Thank you, I do have a key already

< Back ” Mext = || Cancel

Click Next to continue.

10. Select the hypervisor you are going to use primarily with StarWind Virtual SAN.
Note: For all non-virtualized Microsoft applications e.g. SQL or Exchange, as well as other hypervisors

like Xen or VirtualBox, select the StarWind Virtual SAN for Hyper-V option.

(=) Setup - StarWind

License key
Which SkarWind solution do you wank to use?

Starwind iSCSI SAM & NAS is designed For use with solutions like YMware wSphere,
Microsoft Hyper-¥ and Citrix XenServer,

Starwind Mative SAN For Hyper-¥ is designed especially For Hyvper-v-based shared
storages.,

(®) Skarwind virtual SAN For wSphere
() Starwind Yirtual SAN For Hyper-¥

< Back || Pext = || Cancel

Click Next to continue.

©2014, StarWind Software Inc. All rights reserved. 10
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11. Click Browse to locate the license file.

(=) Setup - StarWind

Select your license key
Where is license key located?

Select where license ke is located, then click Mext.

Location of Starwind license file:

|| | | Browse...

< Back || Mext = || Cancel

Click Next to continue.

12. Review the licensing information.

(=) Setup - StarWind — L= -

Apply your license key

Here is lisked information about license key File that vou provided, Press "Mext"
ta apply this license key.

Produck: Starwwind iSC5I SAN (TRIAL)
Mame: Simon Bolivar

Organization: Starwind

Expire Date: 20140611

mumber of servers: 3

< Back. || Mext = || Cancel

Click Next to apply the license key.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 1
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13. Verify the installation settings. Click Back to make any changes.

(=] Setup - StarWind

Ready to Install
Setup is now ready to begin installing Starind on wour computer,

Click Install ko continue with the installation, or dick Back if wou wank ko review or
change any setkings,

Destination location: -
Ci\Program FilesiStarwind Softwareh Starkvind

Setup bype:
Full installation

Selected components:
ISCST Server
Loopback Acceleratar Driver
Management Console
W3AM Deployment Tool
Ma3 Configuration Tool
¥2% Converter Tool

= Back ” Install || Cancel

Click Install to continue.

14. Select the appropriate checkbox to launch the StarWind Management Console immediately after
setup wizard is closed.

Setup - StarWind = =] =

Completing the StarWind Setup
Wizard

Setup has Finished instaling Starwind on your computer, The
application may be launched by selecting the installed icons,

lick Finish ko exit Setup,

Launch Starwind Management Console:

Click Finish to close the wizard.

Repeat steps 2 to 14 on the second server where you wish to install StarWind Virtual SAN.

Note: To manage StarWind Virtual SAN installed on a Server Core OS edition, StarWind Management
console has to be installed on a different computer running the GUI-enabled Windows edition.

©2014, StarWind Software Inc. All rights reserved. 12
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CREATING HIGHLY AVAILABLE STORAGE FOR THE FAILOVER CLUSTER

1. Launch the StarWind Management Console: double-click the StarWind tray icon.

Note: StarWind Management Console cannot be installed on an operating system without a GUL You
can install it on any of the GUI-enabled Windows Editions including the desktop versions of Windows.

o StarWind Management Console =mE |
FILE HOST TARGET TOOLS OFTIONS HELP

Cx 0 0 & =& @

Refresh Conmect Disconmect Add Server Remove Server  Add Device Remove Device  Help

$ Clusters General Conhguration CHAP Permisssons Access Rights Server Log Everts Pedormance
2 rl:l Servers

* [ swiswcom17216011):2 I:l SW1.SW.COM [ 172.16.0.11 ) : 3261

Server Y Add Target % Add Device

| o Add Control Device <% Add to Cluster
3 Refresh

Authenticatson Basi

Statug Legged-in

License Type Enterprise HA [High Availability) unlimited Editicn
Muszrvurn Storage Capacity Undsrritied

Sercers per License 3

| StarWind Software | Resdy

If StarWind Service and Management Console are installed on the same server, the Management
Console will automatically add the local StarWind instance to the Console tree after the first launch.
Then, the Management Console automatically connects to it using the default credentials. To add
remote StarWind servers to the console use the Add Server button on the control panel.

Note: The default login and password are “root” and “starwind”. You can always change them later. It's
strongly recommended to change the default username/password to protect your StarWind Server
from unauthorized access!

2. StarWind Management console will ask you to specify the default storage pool on the server you're
connecting to for the first time. Please configure the storage pool to use the one of the volumes
you've prepared earlier. All the devices created through the Add Device wizard will be stored on it.
Should you decide to use an alternative storage path for your StarWind virtual disks, please use the
Add Device (advanced) menu item.

starwind Management Consale

Storage pool is not configured!
Would you like to set the default location of the storage
pool to My Computer\E?

| ......... — || Choose path.. || Disconnect

..............................

©2014,Starind Software Inc. Al ghts reserved. 13
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Press Yes button to configure the storage pool. Should you require to change the storage pool
destination, press Choose path... and point the browser to the necessary disk.

Note: Each of the arrays which will be used by StarWind Virtual SAN to store virtual disk images has
to meet the following requirements:

* initialized as GPT
* Have asingle NTFS-formatted partition

* Have adrive letter assigned
3. Select the StarWind server where you wish to create the device.
4. Press the Add Device (advanced) button on the toolbar.
9. Add Device Wizard will appear. Select Hard disk device and click Next.
6. Select Virtual disk and click Next.

1. Specify the virtual disk location and size.

(©) Add Device Wizard

Virtual Disk Location

Path to virtual Device Header File
| My Computer \EWitness. swdsk w | I:‘

(® Create new File

E s

() Use existing File

(®) Use 512 bytes sector size

() Use 4096 bytes sector size. May be incompatible with some dients

Mext || Cancel

Click Next.

©2014,Starind Software Inc. Al ights reserved. 1
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8. Specify virtual disk options.

Virtual Disk Options

(®) Thick-provisioned

() Thin-provisioned

Press "Cptions...” to change LSFS Options

Mesxt || Cancel

Click Next.

9. Define the caching policy and specify the cache size (in MB).

Specify Device Cache Parameters

Mode
( Write-Back

Writes are performed asynchronously, actual Writes to Disk are delayed, Reads
are cached

] Write-Through
Writes are performed synchronously, Reads are cached

O NjA
Reads and Writes are not cached

[ set Maximum available Size

Size in MB

Mesxt || Cancel

Click Next.

©2014,Starind Software Inc. Al ights reserved. 5
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10. Define the L2 caching policy and size if necessary. Click Next to continue.

1. Specify the destination directory for the L2 cache, if any.

Note: It is strongly recommended to use SSD-based storage for L2 caching.

12. Specify target parameters.

Select the Target Name checkbox to enter a custom name of a target.
Otherwise, the name will be generated automatically based on the target alias.

B

(<) Add Device Wizard

Target Parameters

Choose a Target Attachment Method

|Create new Target W |

Target Alias
| Witness |

[ ]Target Mame
ign. 2008-08. com. starwindsoftware:sw 1. sw. com-witness

Allow multiple concurrent iISCSI Connections

Mext || Cancel

Click Next to continue.

13. Click Create to add a new device and attach it to the target. Then click Finish to close the wizard.

©2014,Starind Software Inc. Al ights reserved. 8
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14. Right-click on the device you just created and select Replication Manager.
e StarWind Management Console \;li-

FILE HOST TARGET TOQOLS OPTIONS HELP

C % B B
= = o /s
Refresh Connect Disconnect Add Server Remove Server Add Device Remove Device  Hel
P
("_ll_:l Clusters -
4[] /=
[0 servers IMAGEFILET
Fl -
El SWI.SW.COM (172.16.0.11) : .:'. Remove Device .:’.Force remove Device §.+Attach to Target..
4 C-W\tness &x Detach from ign.2008-08.com starwindsoftware:sw1.sw.com-witness & Extend Image Size...
= = Replication Manager
gL “ Remove Device

lel
El SW2.5W.COM (172.1€ % Force remove Device nputer\E\Witness.img
g+ Attach to Target...

c'“ Detach from ign.2008-08.com.starwindsoftware:swl.sw.co..

153

é Extend Image Size...

% Replication Manager

Serial Id 90B27AGBA2CA52T3
Asynchrenous Mode Ves

CACHE

Made Write-Back

Size 100

15. Replication Manager Window will appear. Press the Add Replica button.

16. Select Synchronous two-way replication.

=t Replication Manager for imagefilel ?| x

~ | =+
e Yo |

Refresh | Add 2 x®

Replication Pa

Replication Wizard

Replication Mode

(- Synchrenous "Two-Way" Replication

Replication Partner must be connected to Client as Source Device as well, MPIO on Client
must be enabled, needs dedicated high Performance Network Connection for
Synchronization

(@] Asynchronous "One-Way" Replication
Replica is used to store replicated Data, Data is stored as Snapshots, Client cannot
connect to Replication Partner, mount Snapshot from Replica to get Access to replicated

Data
PROPERTIES
Heartbeat Node
Host Name Heartbeat node is used to prevent split-brain issue in case of loss of connection (both
Target N sync and heartbeat channels) between nodes, This node doesn't store any data. It can
arg ame be placed to dient side to ensure that HA node with healthy connection to dient machine
Mode remains in service in case when inter-node connection is completely lost,
Pricrity

Synchrenizati

Synchrenizati

Heartbeat Cha Mext || Cancel |

Close

Click Next to proceed.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 17
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11. Specify the partner server IP Address or Host name.
Default StarWind management port is 3261. If you have configured a different port, please type it in
the Port number field.

Add Partner Node

Specify Partner Host Name or IF Address where Replication Node would be created

Host Name or [P Address | 172.16.0.22

Port Murmber | 3261

[ Mext || Cancel

Click Next.

18. Choose Create new Partner Device

Partner Device Setup

®  Create new Partner Device
Existing Device Parameters would be used as a Template

) Select existing Device
Select existing Device on Partner Server

Click Next.

©2014,Starind Software Inc. Al ghts reserved. 8
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19. On this screen you can select the synchronization and heartbeat channels for the HA device.
You can also modify the ALUA settings and modify the target name of the device.

=

() Replication Wizard

MNetwork Options for Synchronous Replication

Metwarks for Synchronization and Heartbeat
Press "Change Network Settings...” to configure Interfaces

Metworks for Heartheat
Press "Change Metwaork Settings...” to configure Interfaces

| Change Network Settings |

ALUA preferred 172,16.0.11, 172.16.0.22

| Change ALUA Settings... |

ign. 2008-08, com. starwindsoftware: 172, 16,0, 22-witness

| Maodify Target Name... |

Mext | | Cancel
Click Change network settings....
20.  Specify the interfaces for synchronization and Heartbeat.
Specify Interfaces for Synchronization and Heartbeat Channels -
Select Synchronization Channel and at least one Heartbeat Channel different from Synchronization Channel
Interfaces Metworks Synchronization and H... Heartbeat
(=
17216022 172.16.0.0 r [
172.16.110.22 172.16.110.0 rd -
172.16.111.22 172.16.111.0 v -
172.16210.22 172.16210.0 I [~
172.16.211.22 172.16211.0 r -
=
172.16.0.11 172.16.0.0 I_ [w
1721611011 172.16.110.0 v -
172.16.111.11 172.16.111.0 rd -
172.16210.11 172.16.210.0 r -
172.16211.11 172.16211.0 I [~
oK | Cancel

Click OK. Then click Next.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved.
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2. Press the Create Replica button. Then click Finish to close the wizard.

22.  The added device will appear in the StarWind Management Console.
(=] StarWind Management Console |;‘£-

FILE HOST TARGET TOOLS OPTIONS HELP

~ v [+ =% + x

-/ re | = o]
Refresh Connect Disconnect Add Server Remove Server Add Device Remove Device  Help

Llr:l Clusters e
+ [ servers = HaMAGET

- -
B swiswcom 17216011):2 HRemove Device & Force remove Device ] Change Partner Authentication Settings..
4 C_W\tness A Change Synchronization Priority... Repl\cat\un Node Interfaces %Rephcatiun Manager
é Extend Size of HA (High Availability) Device...

=
HAlmage1
-8 Device HAImagel
SW2.SW.COM (172.16.022): = Size 168
+ & witness Target Name iqn.2008-08.com.starwindsoftware:swl.sw.com-witness
Virtual Disk imagefilel
=
HAImage1 Serial 1d 0B2TABEAZCASZT _
Priority First
Mode: Synchronous
Auto Synchronization after Yes
Failure
Synchronization Status Synchronized
STORAGE
Device imagefilel
Virtual Disk My Computer\E\Witness.img
Persistent Reservations Yes
Size 168
Virtual Disk Sector Size 512 Bytes
Read-Only Mode No
Headler Size in Bytes 0
Serial ld

StarWind Software | Ready

Repeat the steps 3 — 20 for the remaining virtual disks that will be used as Cluster Shared Volumes.

Once all devices are created the Management console should look as follows:

(=) StarWind Management Consale bli-

FILE HOST TARGET TOOLS OPTIONS HELP
~ v [+ =x +
(9 A - -

Refresh Connect Disconnect Add Server Remowe Server Add Device Remove Device  Help

d@ Theas General Configuration CHAP Permissions Access Rights Server Log Events Perfermance
“ I-_El Servers

. EI SWI1.SW.COM (172.16.0.11) : 2 EI SW1.SW.COM (172.16.0.11) : 3261

4 <>- Witness

A% Disconnect  [Cf Remove Server  ¢F Add Target =% Add Device

) HAlmage1 =} Add Device (advanced) ¢} Add Control Device 8 Add to Cluster
g !Z)—Target Groups Manager CRefresh
C_ csvr
Address
(]
Llilnade2 Server Name
<G Port
Authentication
(1
HAImage3 Status Logged-in
4 |:| SW2.SW.COM (172.16.0.22 ) : 3 License Type Enterprise HA (High Availability) unlimited Edition
Maximum Storage Capacity Unlimited
iy
<> Witness Servers per License 3
= HAlmage1
« G osvy
= HAlmage2
“resve
= HAlmage3
< ] >

StarWind Software | Ready

Note: It is recommended to create at least one CSV volume per cluster node according to StarWind
Virtual SAN best practices.

www.starwind.com ©2014, StarWind Software Inc. All rights reserved. 20
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DISCOVERING TARGET PORTALS

In this chapter we will connect the previously created disks to the servers that will be added to
the cluster:

1. Launch Microsoft iSCSI Initiator: Start > Administrative Tools > iSCSI Initiator or iscsicpl from
the command line interface. The iSCSI Initiator Properties window appears.

2. Navigate to the Discovery tab.

3. Click the Discover Portal button. Discover Target Portal dialog appears. Type in 127.0.0.1.

Discover Target Portal

Enter the IP address or DMS name and port number of the portal you
want to add.

To change the default settings of the discovery of the target portal, dick
the Advanced buttan.

IF address or DNS name:

Port: (Default is 3260.)

127.0.0.1 3260
[ [ |

Click the Advanced button. Select Microsoft ISCSI Initiator as your Local adapter and select your
Initiator IP (leave default for 127.0.0.1).

General | [Psec

Advanced Settings

B

Connect using
Local adapter:
Initiator IP:

Target portal IP:

CRC [ Checksum
[pata digest

[ ]Enable CHAP log on

| Microsoft i5CsT Initiator

|Defau|t

[[IHeader digest

Click OK. Then click OK again to complete the Target Portal discovery.

www.starwind.com
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4. Click the Discover Portal... button again.

iISCSI Initiator Properties -

Targets | Discovery |Favorite Targets | Volumes and Devices I RADIUS I Configuration |

Target portals
The system will look for Targets on following portals:
Address Port Adapter IP address
127.0.0.1 3260 Microsoft iSCSI Initiator Default

To add a target portal, dick Discover Portal, Discover Portal. ..
To remove a target portal, select the address above and

then dick Remove,

9. Discover Target Portal dialog appears. Type in the first IP address of the partner node you will use to
connect the secondary mirrors of the HA devices.

Discover Target Portal -

Enter the IP address or DMS name and port number of the portal you
want to add.

To change the default settings of the discovery of the target portal, dick
the Advanced button.

IP address or DMS name: Port: (Defaultis 3260.)

| 172.16.210.22 | | 3260 |

5] [ |

Click Advanced.

6. Select Microsoft ISCSI Initiator as your Local adapter, select the Initiator IP in the same subnet
as the IP address on the partner server from the previous step.

Advanced Settings _

General | IPsec

Connect using
Local adapter: |Micrcsof't i5CSI Initiator W |
Initiator IP: | 172.16.210.11 ] |

Target portal IP:

CRC | Checksum
[ Data digest [IHeader digest

[ Enable CHAF log on
CHAP Log on information

Click OK. Then click OK again to complete the Target Portal discovery.
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1. Click the Discover Portal button once again.

Discover Target Portal dialog appears. Discover Target Portal dialog appears. Type in the second IP
address of the partner node you will use to connect the secondary mirrors of the HA devices.

Select Microsoft ISCSI Initiator as your Local adapter, select the Initiator IP in the same subnet as
the IP address on the partner server from the previous step.

Advanced Settings _

General | Ipsec

Connect using
Local adapter: |Mi|:rnsnft iSCSI Initiator W |
Initiator IP: | 172,16.211.11 W |

Target partal IP:

CRC / Checksum
[[pata digest ["|Header digest

[]Enable CHAP log on

Click OK. Then click OK again to complete the Target Portal discovery.

8. All target portals added on the first node.

ISCSI Initiator Properties -

| Targets | Discavery |Favorite Targets I Volumes and Devices | RADIUS I Configuration |

Target portals

The system will look for Targets on following portals:
Address Port Adapter IP address
127.0.0.1 3260 Microsoft iSCSI Initiator Default
172.16.210.22 3260 Microsoft ISCSI Initiator 172.16.210.11
172.16.211.22 3260 Microsoft iSCSI Initiator 172.16.211. 11

To add a target portal, click Discover Portal. Discover Portal...
To remove a target portal, select the address above and
then didk Remove.

9. Complete the same steps for the second node.

10. All target portals added on the second node.

ISCSI Initiator Properties -

| Targets | Discavery |Favoribe Targets I Volumes and Devices | RADIUS I Configuration |

Target portals

The system will look for Targets on following portals:
Address Part Adapter IP address
127.0.0.1 3260 Microsoft iSCSI Initiator Default
172.16.210.11 3260 Microsoft iSCSI Initiator 172.16.210.22
172.16.211.11 3260 Microsoft ISCSI Initiator 172.16.211.22

To add a target portal, dick Discover Portal. Discover Portal...
To remove a target portal, select the address above and
then dick Remove,
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CONNECTING TARGETS AND CONFIGURING MULTIPATHING

1. Click the Targets tab. The previously created targets are listed in the Discovered Targets section.
Note: If the created targets are not listed, check the firewall settings of the StarWind Server as well
as the list of networks served by the StarWind Server (go to StarWind Management Console ->
Configuration -> Network).

ISCSI Initiator Properties -

Targets |Diso::nc'erl‘-I | Favorite Targets I Volumes and Devices | RADIUS I Configuration |
Quick Connect

To discover and log on to a target using a basic connection, type the IP address or
DS name of the target and then dick Quick Connect.

Target: | | | Quick Connect...
Discovered targets

Mame Status

ign. 2008-0&, com. starwindsoftware: 172,16.0, 22csv1 Inactive

ign. 2008-08.com. starwindsoftware: 172.16.0.22-csv2 Inactive

ign. 2008-0&, com. starwindsoftware: 172, 16,0, 22-witness Inactive

ign. 2008-03. com. starwindsoftware: sw 1.sw. com-csv 1 Inactive

ign. 2008-0&, com. starwindsoftware:sw 1.sw. com-csv2 Inactive

ign. 2008-08. com. starwindsoftware: sw 1.sw. com-witness Inactive

To connect using advanced options, select a target and then Connact
dick Connect.

To completely disconnect a target, select the target and Di =
then dick Disconnect. seonne
For target properties, induding configuration of sessions,

P ties...
select the target and dick Properties. roperoes

For configuration of devices associated with a target, select

Devices...
the target and then dick Devices. Evices

ok || cancel Apply

2. Select a target located on the local server and click Connect.

3. Enable both checkboxes. Click Advanced...

Connect To Target -

Target name:

| ign. 200&-08. com. starwindsoftware:sw 1.sw.com-witness |

Add this connection to the list of Favorite Targets.
This will make the system automatically attempt to restore the
connection every time this computer restarts.

Enable mult-path

0K | | Cancel
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4. Select Microsoft iSCSI Initiator in the Local adapter text field.

9. In the Target portal IP select 127.0.0.1. Click OK.
Advanced Settings _

General | Ipgec

Connect using

Local adapter: |Microsof't I5CSI Initiator W |
Initiator IP: |Default v |
Target portal IP: [127.0.0.1/ 3260 v
CRC / Checksum

[ Data digest [IHeader digest

["]Enable CHAP log on
CHAP Log on information

To use, specify the same name and CHAP secret that was configured on the target for this
initiator. The name will default to the Initiator Mame of the system unless another name is
specified.

ign. 1991-05. com. microsoft:sw 1.sw.com

Perform mutual authentication

Use RADIUS to generate user authentication credentials

Use RADIUS to authenticate target credentials

ek [ cancel Apply

6. Select the partner-target from other StarWind node and click Connect..

Connect To Target .

Target name:

| ign. 2008-08. com. starwindsoftware: 172, 16.0. 22-witness ‘

Add this connection to the list of Favorite Targets.
This will make the system automatically attempt to restore the
connection every time this computer restarts.

Enable multi-path

oK | | Cancel
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1. Select Microsoft iSCSI Initiator in the Local adapter text field. In the Initiator IP field select the IP
address. In the Target portal IP select the corresponding portal IP from the same subnet.

Advanced Settings _

Gereral | IPsec

Connect using

Local adapter: |Microsof't iSCSI Initiator W |

Initiator IP: |1?2.16.210.11 v |

Target portal IP: | 172,16.210.22 | 3260 W |

CRC / Checksum
[ Data digest [IHeader digest

[ Enable CHAF log on

Click OK.

8. Select the same target like in step before and again click Connect.

Connect To Target -

Target name:
| ign. 2008-08. com. starwindsoftware; 172, 16.0, 22-witness ‘

Add this connection to the list of Favorite Targets.

This will make the system automatically attempt to restore the
connection every time this computer restarts,

Enable multipath

CK | | Cancel

Press Advanced.

9. This time in target portal IP in dropdown list select another data channel IP addresses for initiator
and target portal.

Advanced Settings _
Gereral | IPsec

Connect using

Local adapter: |Microsof't i5CSI Initiator v |
Initiator IP: [172.18.211.11 v]
Target portal IP: |1?2.16.211.22,’ 3260 v|

CRC f Checksum
[ Data digest [1Header digest

[ Enable CHAF log on

Click OK, click OK again to connect to the target.
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10. Repeat actions described in the steps above for other HA devices (CSV1 and CSV2).

11. Repeat steps 1-10 of this section on the second StarWind node, specifying corresponding local and
data channel IP addresses. The result should look like on the screenshot below.

ISCSI Initiator Properties .

Targets |Disco\-'er5-I | Favorite Targets I Volumes and Devices I RADIUS I Configuration |
Quick Connect

To discover and log on to a target using a basic connection, type the IP address or
DNS name of the target and then dick Quick Connect.

Target: | Quick Connect...

Discovered targets

Mame Status

ign. 2008-08. com.starwindsoftware: 172.16.0. 22-csv 1 Connected
ign. 2008-08. com.starwindsoftware: 172, 16,0, 22-csv2 Connected
ign. 2008-08. com.starwindsoftware: 172, 16,0, 22-witness ~ Connected
ign. 2008-08. com.starwindsoftware:sw 1.sw.com-csw1 Connected

ign. 2008-08. com. starwindsoftware:sw 1.sw.com-csw2 Connected
ign. 2008-08. com.starwindsoftware:swi.sw.com-witness ~ Connected

To connect using advanced options, select & target and then

dick Connect. Connect

To completely disconnect a target, select the target and Di =
then dick Disconnect. isconne:

For target properties, induding configuration of sessions,

select the target and dick Properties. e

For configuration of devices assodated with a target, select Devices. ..
the target and then dick Devices.

12. Once all targets are connected, launch the MPIO manager: Start > Administrative Tools > MPIO
Or mpiocpl from the command line interface. MPIO manager window will appear.

Go to the Discover Multi-Paths tab and enable the Add support for iSCSI devices checkbox.

MPIO Properties -

MPIC Devices | Discover Multi-Paths |DSM Instal I Configuration Snapshot |

SPC-3 compliant

Device Hardware Id

Add support For (3C51 devices
Add support: For 545 devices

Press the Add button. Restart the server to apply the changes. After the server is restarted, wait for the
HA devices to resynchronize. Repeat step 12 on the second StarWind node once the synchronization
is finished.

©2014,Starind Software Inc. Al ghts reserved

2]



HARDWARE-LESS VM STORAGE =< StarW:nd

S O FTWARE

13. After both StarWind nodes are restarted and the MPIO support is enabled you have to configure the
MPIO policy for each device specifying localhost (127.0.0.1) as the active path.

iISCSI Initiator Properties -

Targets |Discmc’er5-I | Favorite Targets I Volumes and Devices I RADIUS I Configuration |
Quick Connect

To discover and log on to a target using a basic connection, type the IP address or
DNS name of the target and then dick Quick Connect.

Target: | Quick Connect...

Discovered targets

MName Status

ign. 2008-08. com.starwindsoftware: 172.16.0, 22-csv 1 Connected
ign. 2008-08.com. starwindsoftware: 172, 16,0, 22-csv2 Connected
ign. 2008-08. com.starwindsoftware: 172, 16,0, 22-witness ~ Connected
ign. 2008-08. com. starwindsoftware:sw 1.sw,com-csv 1 Connected
iqn. 2008-08. com. starwindsoftware:sw1.sw.com-csw? Connected

ign. 2008-08. com.starwindsoftware:sw1.sw.com-withess ~ Connected

Ta connect using advanced options, select 3 target and then Connect
dick Connect,

To completely disconnect a target, select the target and Di ot
then dick Disconnect. isconne:

For target properties, including configuration of sessions, P i
select the target and dick Properties. U=

For configuration of devices associated with a target, select Deviess
the target and then dick Devices,

Select a target and click Devices...

14. Devices dialog appears. Click MPIO.

Devices -

Mame Address
Disk 2 Port 3: Bus 0: Target 0: LUM O

Volume path names:

Legacy device name: W \PhysicalDrive2

\\?\mpio #disk&ven_starwind&prod_starwind&rev_00C
Device interface name:

< m *
Configure Multipath IO (MPIO)
To configure the MPIO policy for a
selected device, dick MPIO,
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15. Select Fail Over Only load balance policy and then designate the local path as active.

Device Details .

MPIO

Load balance policy:

|Fail Ower Only W

Description

The fail over policy employs one active path and designates all
other paths as standby. The standby paths will be tried on a
round-rohin approach upon failure of the active path until an
available path is found.

This device has the following paths:

Path Id Status Type Weight Session ID
0x7703... Conne... Active nfa fHffe000009fe020-40001
0x7703... Conme... Standby nfa fffe000009fe020-40001
0x7703... Conne... 5Standby njfa ffe000009fen20-40001
< m >
| Dewls || Edt. |
| oK | | Cancel | | Apply |

16. You can check that 127.0.0.1 is the active path by selecting it from the list and clicking Details

MPIO Path Details -
Path identifier: 077030000
Sezzion identifier: ffffe000009fe020-40000 13700000006
Initiator: Microsoft iSCSI Initiator

Connections

The identified path has the following connections:

Source Portal Target Portal Connection ID
0.0.0.0/41664 127.0.0.1/3280 Ox5

11. Repeat the same steps on the second node.

18.1nitialize the disks and create partitions on them using the computer management snap-in. It is
required that the disk devices are visible on both nodes to create the cluster.

Note: it is recommended to initialize the disks as GPT.
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1. Open Server Manager. Select the Failover Cluster Manager item from the Tools menu.

File Action View Help

«=|E 8=

&4, Failover Cluster Manager

[= L=

Failover Cluster Manager

Failover Cluster Manager ~ | Actions

i Create failover clusters. validate hardware for poteniial ailover dusters. and perform configuration changes to Failover Cluster Mana... «
TS i Validate Configuration...

] Create Cluster...

A~ Qverview EH Connectto Cluster...

Adailover cluster is 2 set of independent computers that work together to increase the availability of server roles. The View »
clustered servers (called nodes) are connected by physical cables and by software. If ane of the nodes fails, ancther
node begins to provide servcss. This procass is known as failover & Refresh
| Refresl
[] Properties
~  Clusters Help
Name Rols Status Node Status

No ftems found,

~ Management

To begin to use failover clustering, first validats your hardware configuration, and then create a duster. After these
steps are complete, you can manage the cluster. Managing a cluster can include copying roles to it from a cluster
running Windows Server 2012 B2, Windows Server 2012. or Windows Server 2008 R2.

8 Validate Corfiguration..

Create Cluster..

9 Connect to Cluster..

~  More Information

Click the Create Cluster link in the Actions section of the Failover Cluster Manger.

2. Specify the servers to be added to the cluster.

A

Befare You Begin

Validation WWaming
Access Point for
Administering the
Cluster

Conrfirmation
Creating Mew Cluster

Summary

%i Select Servers
i K

Create Cluster Wizard

Add the names of all the servers that you want to have in the cluster. “ou must add at least one server.

Enter server name: | | Browse ..

swl.sw.com
sw2.sw.com

Selected servers:

< Previous || Meat = | | Cancel

Click Next to continue.
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3. Validate the configuration by passing the cluster validation tests: select “Yes..”

= Create Cluster Wizard -

#] Validation Warning
g

Before You Begin ) For the servers you selected for this cluster, the reports from cluster configuration validation tests
Sdlect Servers . appearto be missing or incomplete. Microsoft supports a cluster solution only if the complete

~ configuration (servers, network and storage) can pass all the tests in the Validate a Configuration
Access Poirt for Do you want to run configuration validation tests before continuing?
Administering the
Cluster

Corfimaton

Creating Mew Cluster
4 @ Yes. When | click Next, un configuration validation tests, and then retum to the process of creating

Summary "~ the cluster.

~ Mo. 1do not require support from Microsoft for this cluster, and therefore do not want to run the
~ wvalidation tests. When | click Next. continue creatina the cluster.

More about cluster validation tests

< Previous || Neaxt = | | Cancel

Click Next to continue.

4. Specify a cluster name.

Note: If the cluster servers get IP addresses over DHCP the cluster also gets its IP address over DHCP
If the IP addresses are set statically, you need to set a cluster IP address manually as well.

A Create Cluster Wizard -

#i Access Point for Administering the Cluster
i ?

Before You Begin Type the name you want to use when administering the cluster.
Select Servers
Cluster Name: SWeluster |
Access Paoint for
é‘iﬂ;ﬂmng e _ The NetBIOS name is limited to 15 characters, One or more IPv4 addresses could not be configured
'@' automatically. For each network to be used, make sure the network is selected, and then type an
Confirmation address.

Creating Mew Cluster
Netwarks Address

Summary
: 172.16.0.0/24 172.16.02

< Previous || Meat > | Cancel

Click Next to continue.

©2014, StarWind Software Inc. All rights reserved. 3l

www.starwind.com



=< StarW:nd

HARDWARE-LESS VM STORAGE
S O FTWARE

9. Make sure that all of the settings are correct. Click Previous to make any changes.

= Create Cluster Wizard -

#] Confirmation
g

Before You Begin ‘You are ready to create a cluster.
Selact Sanvars The wizard will create your cluster with the following settings:
Access Point for
Administering the Cluster: SWeluster
Cluster Node: sw2.sw.com
Node: swl.sw.com

T MEn T IP Address: 172.16.0.2

Summary

Add all eligible storage to the cluster.
To continue, click Mest.

< Previous || Mest > | Cancel

6. The process of cluster creation starts. After it is completed, the system displays a report with detailed

information.
& Create Cluster Wizard -
Summary
Before You Begin You have successfully completed the Create Cluster Wizard.
Access Point for
Administering the
Cluster
Corfimaton Create Cluster

Creating Mew Cluster

Cluster: Sweluster

Node: sw2.5w.com

Node: swl.sw.com

Quorum: Mode and Disk Majority (Cluster Disk 1)
IP Address: 172.16.0.2

To view the report created by the wizard, click View Report.

To close this wizard, click Finish.

Click Finish to close the wizard.
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ADDING CLUSTER SHARED VOLUMES

To add Cluster Shared Volumes (CSV) that is necessary to work with Hyper-V virtual machines:
1. Open Failover Cluster Manager.
2. Go to Cluster->Storage -> Disks.

3. Right-click the required disk and select Add to Cluster Shared Volumes.

= Failover Cluster Manager == -
File Action View Help
e 2
-sée; Failover Cluster Manager Disks (3) Actions
4 fj? SWeluster.sw.com 5 -
Search 4 Queries -
[ Roles -—-En v | Disks
= MNodes MName Status Assigned To COwner Node Disk Mumber | lj Add Disk
&l
4 |y Storage 2 Cluster Disk 1 (#) Orline Disk Witness in Guorum swl 4 |5 Move Available Storage  »
33 o
Léj Disks 3 Cluster Disk 2 @ Oniline Cluster Shared Volume sw2 4 View »
Pools —
E ) :
iﬂ Networks &4 Cluster Disk 3 @ Online Available Sto ; - - swl 3 [6] Refresh
Cluster Events v | Bring e Fl Hel
3 | Take Offline P
|lJ Add to Cluster Shared Volumes ‘ Cluster Disk 3 -
gﬂ ation Details ﬁ Bring Online
Show Critical Events g"_-]! Take Offline
More Actions » i Addto Cluster Shared ...
e | Remove a Information Details...
B z = Show Critical Events
roperties
Mare Actions 3
< m 3| | =% Remove
= B Properties
v _%Guﬂer[ﬁskB Help
m
CEV2(G)
e | ]
W7 NTFS 249 GB free of 25.0 GB
Disks: Cluster Disk 3

Once the disks are added to the cluster shared volumes list you can start creating highly available virtual
machines.

Note: to avoid unnecessary CSV overhead configure each CSV to be owned by one cluster node. This
node should also be the preferred owner of the VMs running on that node.
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General Information:  info@starwindsoftware.com
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Phone: 1-617-449-7717
Fax:  1-617-507-5845

EMEA and APAC
Phone:  +44-0-2071936727
+44-0-2071936350
+33-0-977197857 (French)
Voice Mail:  1-866-790-2646

StarWind Software Inc.
301 Edgewater Place, Suite 100,
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